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CHAPTER

Inside the InDesign 
Interface

IN THIS CHAPTER
Understanding global and 

local control

Identifying InDesign 
terminology

Discovering what’s inside the 
application folder

Exploring the document 
window

Working with multiple 
document windows

Using tools, panels, and docks

Reviewing menu commands

Undoing what you’ve just 
done if you change your 
mind

The first time you use a program, it can be overwhelming. You’re not 
sure what you can actually do with the program, and each program 
has its own interface idiosyncrasies. InDesign is no different. If you’re 

familiar with other Adobe applications, such as Dreamweaver or Photoshop, 
the InDesign software interface will be familiar to you. Even if you’ve been 
using QuarkXPress, you’ll be able to translate much of what you see in 
InDesign to QuarkXPress terms.

When you first launch InDesign, you see the Tools panel on the left, and you 
may see several other panels on the right. InDesign is ready for you to open a 
document and start working.

However, taking a few minutes to familiarize yourself with the interface is 
invaluable to learning new software. Without a basic understanding of what 
you’re looking at on-screen, it’s difficult to begin working in InDesign. And 
even if you’ve used InDesign before, Adobe has some changes to its interface 
in this version, so it’s worth your while to peruse this chapter to see what’s 
changed.

Note
InDesign lets you change both its menu options and the shortcuts associated 
with menu and other commands (see Chapter 3). Throughout the book, I 
assume that the menu arrangements and shortcuts you’re using are the 
default ones. n

07_607169-ch01.indd   307_607169-ch01.indd   3 4/22/10   7:40 PM4/22/10   7:40 PM



Part I: Welcome to InDesign

4

Understanding Global and Local Control
The power of desktop publishing in general, and InDesign in particular, is that it lets you automate 
time-consuming layout and typesetting tasks while enabling you to customize each step of the pro-
cess according to your needs. In InDesign, you use global controls to establish general settings for 
layout elements and then use local controls to modify those elements to meet specific publishing 
requirements. The key to using global and local tools effectively is to know when each is appropriate.

Global tools include:

l General preferences and application preferences (see Chapter 3)

l Master pages (see Chapter 7)

l Text styles (see Chapters 7, 20, and 21)

l Table and cell styles (see Chapters 7 and 24)

l Object styles (see Chapters 7 and 13)

l Stroke styles (see Chapter 12)

l Text variables (see Chapter 25)

l Sections of page numbers (see Chapter 5)

l Color definitions (see Chapter 8)

l Hyphenation and justification (see Chapter 19)

l Libraries (see Chapter 7)

Note
Styles and master pages are the two main global settings that you can expect to override locally throughout a 
document. This is the case because although the layout and typographic functions that styles and master pages 
automate are the fundamental components of any document’s look, they don’t always work for all of a publica-
tion’s specific content. n

Local tools include:

l Frame and shape tools (see Parts III and IV)

l Character and paragraph tools (see Chapters 19 through 23)

l Graphics tools (see Part IV)

In many cases, it’s obvious which tool to use. If, for example, you maintain certain layout stan-
dards throughout a document, using master pages is the obvious way to keep your work in order. 
Using styles is the best solution if you want to apply standard character and paragraph formatting 
throughout a document. When you work with special-case documents, such as single-page display 
ads, it doesn’t make much sense to spend time designing master pages and styles — it’s easier just 
to format one-of-a-kind elements on the fly.
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In other cases, deciding which tool is appropriate is more difficult. For example, you can create a 
drop cap (a large initial letter set into a paragraph of type, like the one that starts each chapter in 
this book) as a character option in the Character panel, or you can create a character style (format-
ting that you can apply to any selected text, ensuring that the same formatting is applied each 

InDesign comes with its own terminology, much of it adopted from other Adobe products. The general 
terms include the following:

l Extension: A piece of software that loads into InDesign and becomes part of it, adding more 
capabilities.

l Frame: The container for an object, whether text, graphic, or color fill.

l Link: The connection that InDesign makes to an imported file. The link contains the file’s 
location, last modification date, and last modification time. A link can reference any image or 
text file that you have imported into a layout. InDesign can notify you when a source text or 
graphics file has changed, so you can choose whether to update the version in your layout. 
(A hyperlink, often also abbreviated to link in casual conversation, connects elements in a 
Web page to other Web pages or other resources such as PDF files.)

l Master page: A template within a layout that contains elements that you want to occur on 
any page that is based on that master page. For example, a specific master page might con-
tain page numbers and the standard text frame for body text, so when you add new pages to 
the document based on this specific master page, those new document pages automatically 
include the page numbers and standard text frames.

l Package: The collection of all files needed to deliver a layout for commercial printing. 
InDesign has a package feature that collects all these files for you.

l Pane: A section of a dialog box or panel whose options change based on the set of controls 
you’ve selected in the dialog box or panel.

l Panel: A container for controls that stays on-screen even when you aren’t using it (in contrast to a 
dialog box, which appears only while you are using it). Panels can be docked to the right edge of 
the screen or free-floating. Panels can be combined into a single container called a panel group.

l Path: A shape in which the endpoint and start point are separate, keeping the shape open. 
Lines are a straight type of path.

l PDF: The Adobe Portable Document Format is the standard for electronic documents. No mat-
ter what kind of computer it is viewed on (Windows, Macintosh, Palm, or Unix), a PDF docu-
ment retains high fidelity to the original in typography, graphics representation, and layout. 
InDesign can place PDF files as if they were graphics and export its own pages as PDF files.

l Place: To import a graphics file or text file.

l Stroke: The outline of an object (whether a frame, a line, or an individual text character).

l Thread: The links between text frames that route stories among them.

InDesign Vocabulary 101
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time) that contains the drop-cap settings and apply that style to the drop cap. The method you 
choose depends on the complexity of your document and how often you need to perform the 
action. The more often you find yourself doing something, the more often you should use a global 
tool (such as character styles).

Fortunately, you don’t have to decide between global and local tools right away while designing a 
document. You can always create styles from existing formatting later or add elements to a master 
page once you find that you need them to appear on every page.

Another situation in which you can choose between local or global controls is specifying measure-
ment values. Regardless of the default measurement unit you set (and that appears in all dialog 
boxes and panels), you can use any unit when entering measurements in an InDesign dialog box. 
If, for example, the default measurement is picas but you’re accustomed to working with inches, go 
ahead and enter measurements in inches.

Cross-Reference
Chapter 3 covers how to apply measurement values and set your preferred defaults. n

Exploring the InDesign Application Folder
Often, users simply launch an application from an alias or shortcut and never even look in the 
application folder. This approach is just fine until it’s time to install a new plug-in or to share 
important information with other users. Familiarizing yourself with the basic contents helps ensure 
that you’re not throwing away anything important and that you’re working with the correct files 
and folders.

If you locate the InDesign application folder on your hard drive and open it, you see that it’s 
chock-full of stuff you may not even recognize. The two folders you need to know about in this 
folder are the Presets folder and the Plug-ins folder.

The Presets folder
The Presets folder contains eight kinds of standards: Shortcut sets, color swatch libraries, work-
spaces, auto-correction tables, find-change tables, button libraries, motion presets for animations, 
and page transitions. InDesign lets you create shortcut sets so that different users can have their 
own shortcut definitions. These preferences are stored in the InDesign shortcut sets folder in the 
Presets folder. Because these preferences are stored in files, they can be copied to other users’ 
Presets folder to help ensure consistent options among all users in a workgroup. Similarly, the 
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seven other kinds of saved standards you can create in InDesign are stored in the Presets folder and 
can be shared with other users by copying them to other users’ Presets folders.

Caution
The Presets folder also contains subfolders that contain components that InDesign needs to function: the 
Default, Flash Export, Multimedia, and Start Page subfolders. Do not alter these folders or their contents. n

The Plug-ins folder
The Plug-ins folder in the InDesign folder contains small software modules, called plug-ins, that 
add both core features and additional, optional features to InDesign. The Plug-ins folder contains a 
variety of subfolders, such as Dictionaries, Filters, and Graphics, that make locating files easy. The 
Plug-ins folder’s plug-ins are components of InDesign itself, and you should not alter its contents.

New Feature
The Required folder used in previous versions of InDesign does not exist in InDesign CS5. Instead, the Plug-ins 
folder now contains all required components of InDesign CS5, and the optional and third-party plug-ins — now 
called extensions — are now managed by the Adobe Extension Manager application, as Appendix A explains. n

The Scripts folder
The Scripts folder in the InDesign folder contains scripts that provide standard InDesign function-
ality, including XHTML Web export (see Chapter 33), e-book export (see Chapter 34), and docu-
ment preflighting (see Chapter 30). You can create your own scripts and store them in the Scripts 
folder, as Chapter 37 explains.

Exploring the Document Window
When you’re running InDesign, the first thing to do is create a new, empty document by choosing 
File ➪ New ➪ Document, or pressing Ô+N or Ctrl+N, and clicking OK immediately. Doing so gives 
you a document window so that you can start exploring the application. (Never mind the settings 
for now — you’re just exploring.)

No matter what size document you’re dealing with or how many pages it has, all documents are 
contained within a standard window. The window provides controls that help you create and place 
objects, change the view scale, and navigate between pages. Figure 1.1 shows all the standard ele-
ments of a new document window.
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 FIGURE 1.1

The standard document window provides controls for managing documents on-screen, changing the view 
scale, displaying different pages, and placing objects on pages. At bottom: The Windows 7 screen is iden-
tical, except for where the window controls reside and stylistic differences between Windows and Mac OS 
X, such as fonts used and border designs.
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Title tab
When you open or create a document, by default InDesign opens a new tabbed window within the 
application frame. Each window is accessed via a tab; click the tab and the desired window 
appears. Each tab has the name of the document, as well as other information about the document:

l The current view percentage is shown at the end of the file name, such as @ 74% to indi-
cate that the document is displayed at 74 percent of actual size.

l An asterisk (*) appears in front of the file name if the document has unsaved changes.

l If multiple windows are open for the same document, InDesign indicates the various win-
dows by adding :1, :2, and so on to each window, with :1 indicating the first window, :2 
the second, and so on. (Note that a colon precedes the number.)

You can close a document quickly by clicking the Close box (the X icon) on the document’s tab.

Cross-Reference
Chapter 2 explains how to work with multiple documents, as well as how to use the old-style document 
windows instead of the tabbed ones introduced in InDesign CS4. n

Rulers
Document windows always display a horizontal ruler across the top and a vertical ruler down the 
left side. The horizontal ruler measures from the top-left corner of the page across the entire 
spread; the vertical ruler measures from the top to the bottom of the current page.

You can use these rulers to judge the size and placement of frames and lines on your page. 
Although InDesign provides more-precise methods for placing objects — such as the Control 
panel, in which you can enter exact values — designers often use the rulers for rough placement 
while they experiment with a design, as shown in Figure 1.2.

Tip
When you create new objects, move them, resize them, or rotate them, InDesign provides an indicator near 
the mouse to show you the object’s current status — called the transformation value — such as size or rotation 
angle, as you can see in Figure 1.2. n

By default, both rulers display increments in picas, but you can change the measurement system 
for each ruler in the Units & Increments pane of the Preferences dialog box (choose InDesign ➪ 

Preferences ➪ Units & Increments or press Ô+K on the Mac, or choose Edit ➪ Preferences ➪ Units 
& Increments or press Ctrl+K in Windows). 

If you do make such a change while no documents are open, the rulers in all new documents 
appear in your preferred measurement systems. If a document is open, the rulers are changed only 
in that open document.

07_607169-ch01.indd   907_607169-ch01.indd   9 4/22/10   7:40 PM4/22/10   7:40 PM



Part I: Welcome to InDesign

10

 FIGURE 1.2

This frame’s right side is aligned with the 28-pica mark on the horizontal ruler (look for the dotted line in 
the ruler right above the frame’s right edge). InDesign also shows the dimensions of a frame as you create 
it using the transformation value indicator to the lower right of the frame as it is being created.

Cross-Reference
Chapter 3 explains ruler increments in more detail. n

If you need more space on-screen or want to preview a design without all the layout tools, you can 
hide the rulers by choosing View ➪ Hide Rulers or pressing Ô+R or Ctrl+R. Most users show the 
rulers all the time out of habit, but the rulers aren’t really necessary in template-driven documents 
such as magazines in which all the placement decisions are indicated by guides and master pages. 
If you’re editing text on a smaller monitor, you might appreciate the space gain of not having rul-
ers, minimal though it might be.

Zero point
The intersection of the rulers in the upper-left corner of the page is called the zero point. Known as 
the ruler origin in other applications, this is the starting place for all horizontal and vertical mea-
surements. If you need to place items in relation to another spot on the page (for example, from
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the center of a spread rather than from the left-hand page), you can move the zero point by click-
ing and dragging it to a new location. The X and Y values in the Control panel and Transform 
panel update as you click and drag the zero point so that you can place it precisely. The zero point 
is document-wide, so it changes for all pages or spreads in the document. To restore the zero point 
to the upper-left corner of the leftmost page, double-click the intersection of the rulers in the 
upper-left corner.

After the zero point is moved, all the objects on the page display new X and Y values even though 
they haven’t moved. Objects above or to the left of the zero point have negative X and Y values, 
and the X and Y values of other objects do not relate to their actual position on the page or spread.

The effects of changing the zero point can be confusing, especially if you’re in a workgroup with 
other users who may change the zero point and forget to restore it to the upper-left corner. To pre-
vent this problem, you can lock the zero point, making it more difficult for users to change it. To 
lock the zero point, Control+click or right-click the zero point and choose Lock Zero Point from 
the contextual menu.

Of course, a user determined to change the zero point can simply choose Unlock Zero Point from 
the contextual menu. But doing so is a conscious act on their part, and the fact that you locked the 
zero point usually sends the message that you want to keep it that way.

Scroll bars
Standard scroll bars run down the right side and across the bottom of the document window. As in 
most applications, you can either click and drag the scroll bars or click the scroll buttons to move 
around on a page or move to other pages in the document.

A powerful but confusing capability in InDesign is something called a reference point. InDesign lets 
you work with objects from nine reference points — any of the four corners, the middle of any of the 
four sides, or the center — such as when you’re positioning the object precisely or rotating the object. 
You choose these reference points in the Control panel or Transform panel, using the grid of nine points 
arranged in a square.

By default, InDesign works with the central reference point, which is great for rotating an object but can 
lead to confusion when you enter in the X and Y coordinates to place it precisely. That’s because most 
people use the upper-left corner of an object when specifying its coordinates, not the center of the 
object. So be sure to change the reference point to the upper left whenever entering X and Y coordi-
nates in the Control or Transform panels. (I use the upper-left reference point in this book unless other-
wise indicated.)

How do you change which reference point is active? That’s easy: Just click the point in that preview 
grid. The active reference point — called the control point — is black, whereas the others are white.

Keep Your Bearings Straight
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Pasteboard, pages, and guides
Inside the rulers, you see a white area surrounding the black, drop-shadowed outlines of your 
pages (see Figure 1.1). The work area surrounding the page is called the pasteboard, and it’s 
designed as a workspace for creating, experimenting with, and temporarily storing objects. You can 
also use the pasteboard to bleed objects off a page so that they print to the edge of a trimmed page. 
Each page or spread in InDesign has its own pasteboard. By default, there’s 1 inch of pasteboard 
above and below each page, and a space equal to the page width to the left and right of each page 
or spread. (As Chapter 3 explains, you can change the pasteboard height and width.) For example, 
a spread consisting of two 4-inch pages has 4 inches of pasteboard to the left and 4 inches of paste-
board to the right, as well as 1 inch of pasteboard above and below.

Pages, drawn with black outlines, reflect the page size you set up in the New Document dialog box 
(choose File ➪ New ➪ Document, or press Ô+N or Ctrl+N). If it looks like two pages are touching, 
you’re looking at a multipage spread. By default, you see magenta lines across the top and bottom 
of each page showing the top and bottom margins you specified when you created the document. 
Violet-colored lines indicate the left and right margins (for single-page documents) or inside and 
outside margins (for facing-page documents). These lines are nonprinting guides that can help you 
position objects.

You can change the placement of these guides by choosing Layout ➪ Margins and Columns, and you 
can create additional guides by clicking and dragging them off the horizontal and vertical rulers.

Cross-Reference
I cover guides in detail in Chapter 7. n

If you can’t see the guide colors well, you can change them for all new documents. When no docu-
ments are open, choose new colors in the Guides & Pasteboard pane of the Preferences dialog box 
(choose InDesign ➪ Preferences ➪ Guides & Pasteboard or press Ô+K on the Mac, or choose 
Edit ➪ Preferences ➪ Guides & Pasteboard or press Ctrl+K in Windows). The Margins color 
changes the horizontal guides and the Columns color affects the vertical guides.

Page controls
InDesign has several controls for maneuvering through pages: page-turning buttons, and the 
Page field and pop-up menu. All are at the bottom left of the document window, as shown in 
Figure 1.1.

Use the Page pop-up menu (to the right of the Page field) to get a list of available pages, including 
master pages (see Figure 1.1).

The Page field and pop-up menu are encased by two sets of arrows; these arrows are page-turning 
buttons, which let you turn pages sequentially or jump to the first or last page in the document. 
From left to right, clicking these arrows takes you to the first page, the previous page, the next 
page, and the last page.
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To jump to a specific page number, highlight the current number in the Page field, type a new 
page number, and press Return or Enter.

Tip
You can use the shortcut Ô+J or Ctrl+J to open the Go to Page dialog box, in which you can select a page 
number to go to. n

To jump to a master page, type the first few characters of the master page’s name in the field. 
Jumping to document pages can be a little more complicated. Because the page number that dis-
plays and prints on the document page does not have to match the position of the page in the doc-
ument — for example, the third page might be labeled iii instead of 3 — there are two methods for 
entering the page number you want to jump to: section page numbers and absolute page numbers. 

Cross-Reference
Chapter 5 covers these page-control methods in detail. n

Reveal pop-up menu
This menu lets you find the original file on your computer using one of three menu options: Reveal 
in Finder (for Mac OS X) or Reveal in Explorer (for Windows), Reveal in Bridge (which opens the 
Adobe Bridge application), and Reveal in Mini Bridge (which opens the Mini Bridge control panel).

Application frame
The application frame lets you put all the InDesign elements in their own container, preventing 
them from floating freely and keeping other applications from peeking through.

You can turn the application frame on or off. If you use a Mac, you’re likely to have it off so that all 
the InDesign interface elements float freely — the standard on Mac OS X. If you use Windows, 
you’re likely to have the application frame turned on, because the Windows default is to provide 
an application frame for all programs. Because InDesign was created to work on both Mac and 
Windows systems, you can use either interface style no matter what type of PC you use.

To hide the application frame (or bring it back), choose Window ➪ Application Frame.

Platform Differences
On the Mac, the application frame is turned off by default. In Windows, it is turned on by default. n

Application bar
Above the Control panel is the application bar, which offers easy access to other Adobe applica-
tions, such as Bridge, and to controls pertaining to various view options (see Chapter 2). The 
application bar appears by default if the application frame is enabled, as shown in Figure 1.1. But 
when the application frame is hidden, you can show or hide the application bar by choosing 
Window ➪ Application Bar.

07_607169-ch01.indd   1307_607169-ch01.indd   13 4/22/10   7:40 PM4/22/10   7:40 PM



Part I: Welcome to InDesign

14

The application bar has eight handy elements. From left to right:

l The first element is the set of quick-access buttons to Bridge and, if you’ve installed 
Creative Suite, other Adobe software.

l The second element is the Zoom Level field and pop-up menu (see Chapter 2). Choose 
a view percentage from the menu or enter a percentage in the field and press Return 
or Enter.

l The third element is the View Options pop-up menu, which lets you hide and show frame 
edges, rulers, various guides and grids, and hidden characters from one handy location. 
(These options are also available through a variety of scattered View menu options and via 
Type ➪ Show/Hide Hidden Characters.)

l The fourth element, the Screen Mode pop-up menu, duplicates the screen-mode buttons’ 
settings at the bottom of the Tools panel (covered later in this chapter).

l The fifth element, the Arrange Documents pop-up menu, gives you fast access to InDesign 
CS5’s controls over how document windows are arranged (covered in Chapter 2).

l The sixth element, the Workspaces pop-up menu, gives you quick access to the work-
spaces you’ve defined (covered in Chapter 2).

l The seventh is the Adobe Community Search field, an online feature that lets you find 
help on the Adobe Community Web site.

l The eighth is Access CS Live, a set of online subscription services (CS Review, Buzzword, 
and Share My Screen) for sharing previews of your documents with others so you can get 
comments and feedback online, as well as to do basic text editing in a shared file.

New Feature
The CS Live service is new to InDesign CS5. The subscription-based collaboration service extends Adobe’s 
previous Acrobat.com offerings, as explained later in this chapter. n

Using Tools
InDesign by default displays a docked panel on the left side of the screen called the Tools panel 
(longtime users also know it as the Toolbox, the name used in early InDesign documentation), 
which contains 31 tools plus 12 other functions. It appears by default at the upper left of the 
screen (see Figure 1.3).

The tools let you create and manipulate the objects that make up your pages. The tools work simi-
larly to those in other Adobe products (such as Photoshop, Illustrator, and Dreamweaver) and they 
work somewhat like the tools in QuarkXPress. But the tools do not work like the toolbars in your 
word processor, which are more like macros that make things happen. With InDesign’s tools, for 
the most part, you select the tool and do something with it — draw a new frame, rotate a line, crop 
an image, and so on.
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 FIGURE 1.3

InDesign’s Tools panel (at left) has 31 tools available, but many are hidden in pop-out menus (shown at 
center). You can see a tool’s name by hovering the mouse over it to get a Tool Tip (at right). The Marker 
tool (at bottom left) appears after you’ve used the Eyedropper tool; it cannot be selected in the Tools panel 
directly.
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Fill

Apply options
Select Contents

Screen Mode options
Marker tool

Stroke

Default Fill and Stroke
Select Container

Note
The one tool not directly accessible from the Tools panel is the Marker tool. It appears after you’ve used the 
Eyedropper tool to select an object’s color, so you can apply that color to another object, as Chapter 8 and the 
special color insert explain. You can also use the Eyedropper tool to select an object’s or text’s attributes and 
then apply those attributes via the Marker tool to another object or to other text, as Chapters 12 and 19 
explain. n

Selecting tools
To select a tool and start using it, click it in the Tools panel. As long as you’re not using the Type 
tool, you can also press a keyboard shortcut displayed in parentheses in the Tool Tips (covered 
later in this chapter).
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In addition to the tools you can see, the Tools panel contains a few hidden tools consolidated into 
little pop-out menus. Any tool with a small arrow in its lower-right corner is hiding one or more 
similar tools, as shown in Figure 1.3. There are several ways to access these hidden tools:

l Control+click or right-click a tool that has a pop-out indicator. When the pop-out 
appears, click one of the new tools to replace the standard tool with the pop-out tool.

l Click and hold a tool that has a pop-out indicator. When the pop-out appears, click one 
of the new tools to replace the standard tool with the pop-out tool.

l Option+click or Alt+click a tool with a pop-out indicator to select the next tool. Each time 
you Option+click or Alt+click a tool, the next tool in the pop-out is selected, even though 
the pop-out itself does not appear.

l Use the keyboard shortcut for the desired tool; Figure 1.3 shows the shortcuts for each.

New Feature
The Option+click or Alt+click method to select a tool is new to InDesign CS5. n

New Feature
InDesign CS5 no longer has the Position tool that combined aspects of the Selection and Direct Selection tools. 
InDesign CS5 adds two new tools — the Page and Gap tools — and rearranges some of the tools on the Tools 
panel. n

Understanding what the tools do
In real life, you can often get by using the wrong tool for a job — using a flat screwdriver instead 
of a Phillips, or a shoe instead of a fly swatter. This doesn’t work in InDesign. Whether you’re typ-
ing text, reshaping an object, or applying a color, there’s one — and only one — tool for each job. 
Loosely organized with the most commonly used tools at the top, the Tools panel includes tools 
for creating and manipulating frames and lines — the objects that make up your designs (see 
Figure 1.3).

Note
Frames are shapes and containers that you can size, position, and reshape with precision. InDesign has three 
types of frames: Empty (unassigned) frames for blocks of color, text frames for type, and graphics frames for 
imported images. By default, most frames are empty but you can easily convert them to text or graphics 
frames. Other frames are created specifically as text or graphics frames. n

Selection tool
The Selection tool (shortcut V or Esc) lets you select objects on the page and move or resize them. 
You might want to rename this tool in your mind as the Mover tool because it’s the only tool that 
lets you drag objects around on-screen.
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Tip
If you’re working with text and have the Type tool selected, you can switch to the Selection tool temporarily 
by holding down Ô or Ctrl instead of using the Tools panel. n

Here’s how the Selection tool works:

l To select any object on a document page, click it. If you can’t seem to click it, it might 
be an object placed by a master page (a preformatted page used to format pages automati-
cally) or it might be behind another object.

l To select an object placed by a master page, press Shift+Ô or Ctrl+Shift while you 
click.

l To select an object that is completely behind another object, Ô+click it or 
Ctrl+click it.

l To select multiple objects, click and drag around the objects or Shift+click them 
individually. Because you need to press Shift anyway while selecting objects placed by 
master pages, you can always multiple-select those objects.

l Then apply the desired transformation or effect. For example, to move selected objects, 
click somewhere within the objects and drag the mouse. To resize a selected object, click 
and drag any handle. (Press Shift+Ô or Ctrl+Shift while you drag to maintain the propor-
tions of the object.) To resize both a selected frame and its graphic, press Ô or Ctrl while 
you drag. Press Shift+Ô or Ctrl+Shift to keep things proportional. To rotate an object, 
hover the mouse just outside a corner; when you see the curved-arrow pointer, you can 
then use the mouse to rotate the object. You can also use the Control panel and the other 
tools explained in Part III on the selected object.

Tip
To resize multiple objects simultaneously via the mouse, you must first group them (choose Object ➪ Group, or 
press Ô+G or Ctrl+G). Otherwise, only the object whose handle is being dragged resizes. Ungroup by choos-
ing Object ➪ Ungroup, or pressing Shift+Ô+G or Ctrl+Shift+G. You can resize multiple selected — but 
ungrouped — objects by using the Control panel or Transform panel. n

Direct Selection tool
The Direct Selection tool (shortcut A) lets you select the contents of graphics frames, such as to 
move them independently of their frames, as well as the nodes in lines and other objects (the 
modes are the hollow circles that appear at corners, at the beginning and end of lines and curves, 
and at direction transitions in curves).

Cross-Reference
Chapter 10 explains InDesign CS5’s selection methods in more detail. Chapter 16 explains how to use the 
Direct Selection tool to work with nodes, which are also known as anchor points. n
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Here’s how the Direct Selection tool works with graphics frames’ contents:

l To select a graphics frame’s contents, click it to display the inside frame for the 
graphic, as shown in Figure 1.4. (The inside frame is brown, whereas the outside frame is 
the current layer’s color, which is blue by default; Chapter 6 explains layers.)

 FIGURE 1.4

Left: A graphics frame with its contents selected using the Direct Selection tool. Right: 
As the content’s inside frame is being reshaped (the top edge is being moved down), 
InDesign shows the entire graphic, including the portion that extends beyond its outside 
frame and thus will not print.

l To select the contents in graphics frames placed by a master page, Shift+Ô+click or 
Ctrl+Shift+click, as with the Selection tool. The Direct Selection tool lets you easily 
select objects behind other objects and select items within groups.

l To select multiple graphics frames’ contents, click and drag around the objects or 
Shift+click them. Because you need to press Shift anyway while selecting objects placed 
by master pages, you can always multiple-select those objects.
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l Then apply the desired effect. For example, to move a graphic within its frame, click 
inside the inside frame and drag the graphic. Or move an inside frame’s edge or corner to 
resize it or reshape it. You can apply effects to the selected inside frame such as rotation 
using the tools in the Control panel or by using the techniques explained in Part III.

Note
Both the Selection and Direct Selection tools can be used for threading (linking) text frames (see Chapter 18). 
This is one of the few cases when you have more than one tool to handle a task. n

Page tool
The new Page tool (shortcut Shift+P) lets you move an entire page’s contents, as well as open a set 
of menu options to change the page size and orientation. Chapter 5 covers this tool in more detail.

Gap tool
The new Gap tool (shortcut U) lets you change the gap between objects by automatically resizing 
the objects as you adjust the gap with the mouse, as Chapter 10 explains.

Type tool
The Type tool (shortcut T) lets you type, edit, and format text. The Type tool also lets you create 
rectangular text frames as you need them. (See Chapters 9 and 18.)

Note
You can place or drag and drop text files, and you can thread (link) text frames with either of the selection 
tools, but those tools won’t let you touch the text. n

Type on a Path tool
The Type tool has a pop-out menu to select the Type on a Path tool (shortcut Shift+T), which lets 
you select a path or frame and type text onto it so that it follows the path or frame’s outline. (See 
Chapter 22.)

Line tool
The Line tool (shortcut \) lets you draw free-standing lines (rules) on your page. To use this tool, 
simply click it and drag the mouse. You can use the rulers, the Control panel, or the Transform 
panel to size and position the line precisely. Pressing Shift while you click and drag constrains the 
line angle to 45-degree increments, which is useful for creating straight horizontal and vertical 
lines. (See Chapter 9.)

Pen tool
The Pen tool (shortcut P) lets you create paths consisting of straight and curved segments. Modeled 
after the Pen tools in Illustrator and Photoshop, this is the tool for creating simple illustrations 
within InDesign. (See Chapter 16.) 
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If a path you create with the Pen tool is left open, the object is essentially a line that you can color 
or adjust stroke settings for. If the path is closed, the object is basically an empty frame. You can 
import text or graphics into the paths using the Place command (choose File ➪ Place or press Ô+D 
or Ctrl+D) or you can type into the path using the Type tool. If you decide to place text or graphics 
in an open path, the path closes automatically and becomes a frame. (To place text on a path, first 
select the Type on a Path tool [shortcut Shift+T] and then click the path.)

Anchor and direction point tools
The Pen tool includes a pop-out menu containing three additional tools for reshaping lines and 
frames: Add Anchor Point (shortcut =), Delete Anchor Point (shortcut – [hyphen]), and Convert 
Direction Point (shortcut Shift+C).

Cross-Reference
For more information about using the Pen and anchor point tools, see Chapter 16. n

Pencil tool
The Pencil tool (shortcut N) lets you draw freeform shapes by having InDesign trace your mouse 
movements, creating a curve based on that automatically. (See Chapter 16.)

Smooth tool
The Pencil tool has a pop-out menu to select the Smooth tool, which lets you smooth lines, curves, 
and shapes. It has no shortcut. (See Chapter 16.)

Erase tool
The Pencil tool also has a pop-out menu to select the Erase tool, which lets you erase portions of 
an object. It has no shortcut. (See Chapter 16.)

Frame tools
InDesign has three frame tools: Rectangle Frame (shortcut F), Ellipse Frame, and Polygon Frame. 
Their icons are distinguished by a large X inside. The latter two tools, which have no shortcuts, are 
available from the Rectangle Frame tool’s pop-up menu. The frames created by these tools are 
meant to hold either graphics or text. To create frames with these tools, click and drag using the 
rulers or information in the Control panel or Transform panel to judge the size and placement. To 
create a perfect circle with the Ellipse Frame tool or a perfect square with the Rectangle Frame tool, 
press Shift while you click and drag. (See Chapter 9.)

You can fill and stroke the empty frames for use as design elements or you can import text and 
graphics into them using the Place command (choose File ➪ Place or press Ô+D or Ctrl+D). You 
can also click in an empty frame with the Type tool to begin typing in it. (See Chapters 9 and 19.)
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Shape tools
If you’d rather create actual graphics frames, use the Rectangle (shortcut M), Ellipse (shortcut L), 
or Polygon (no shortcut) tools. (The Ellipse and Polygon tools are pop-out tools available from the 
Rectangle tool.) The tools are meant to create shapes that you use as artwork rather than as con-
tainers, but you can place text or graphics into one of these shapes the same way as you would a 
frame. (See Chapter 9.) Essentially, the shape tools are superfluous and you can ignore them.

Scissors tool
The Scissors tool (shortcut C) lets you cut paths into separate paths. When you cut an open path 
(a line or curve), you get two separate lines. When you cut a closed path in one place, you get an 
open path. When you cut a closed path (a frame) in two places, you get two closed paths contain-
ing the same contents. Note that you cannot cut paths containing text. (See Chapter 16.)

Free Transform tool
The Free Transform tool (shortcut E) is handy because it lets you move, rotate, and reshape objects 
all with one tool. If you click and hold the mouse within the object, you can drag it. If you click 
any of the handles on the object frame, you can resize it. If you click and hold on any edge (except 
where there is a handle) or anywhere outside the object, you can rotate the object. (See Chapter 11.)

New Feature
In InDesign CS5, the Rotate, Scale, and Shear tools now reside in the Free Transform tool’s pop-out menu. And 
you no longer even need to use the Free Transform or Rotate tools to rotate an object or its content, as 
Chapters 10 and 11 explain. n

Rotate tool
The Rotate tool (shortcut R) lets you change the angle of selected items visually. To use the Rotate 
tool, first select an item with the Selection tool or the Direct Selection tool and then select the 
Rotate tool; or Ô+click or Ctrl+click an object with the Rotate tool. Click and drag in any direc-
tion. The object rotates from the location of the active reference point, as shown in Figure 1.5.

The active reference point is indicated through the nine boxes in the upper left of the Control 
panel or Transform panel — the black square is the active reference point (also called control point) 
from which the rotation pivots and from which all coordinates originate. Just click whatever square 
you want to be the active reference point. You can also click and drag the active reference point to 
a new location for a custom rotation.

Tip
To rotate an object in 45-degree increments, press Shift while you click and drag. n

Scale tool
The Scale tool (shortcut S) lets you grab any object and resize it horizontally, vertically, or propor-
tionally. When you scale text or graphics frames, the text or image within them is resized as well. 
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As with the Rotate tool, the Scale tool doesn’t let you select items to scale. You either need to select 
an object first with a selection tool or Ô+click or Ctrl+click it with the Scale tool. (See Chapter 11.)

Shear tool
The Shear tool (shortcut O) works much the same as the Scale tool. Rather than resize the object 
and contents, the Shear tool slants selected objects in the direction you drag. But it also rotates the 
object, creating a more three-dimensional perspective effect. (See Chapter 11.)

 FIGURE 1.5

Objects rotate based on the active reference point: At right, the active reference point is the center point; 
at left it is the lower-right corner.

Gradient Swatch tool
The Gradient Swatch tool (shortcut G) lets you change the direction of existing gradient fills or 
strokes applied to objects. To apply gradients to objects, you use the Gradient panel. (See Chapter 8.)

Gradient Feather tool
The Gradient Feather tool (shortcut Shift+G) acts just like the Gradient Swatch tool except that it 
fades the gradient to transparent rather than to a solid color, providing a quick way to apply a 
feathering effect. (See Chapter 12.)
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Note tool
The Note tool lets you insert a nonprinting note (such as a reminder to yourself or another 
designer) in text. After selecting the tool, click in any text to insert the note. The Notes panel 
opens, in which you can type the note and navigate to other notes. (See Chapter 19.)

Eyedropper tool
The Eyedropper tool (shortcut I) samples the color and other formatting settings for the object at 
the location you click with it, as well as for text you click with it. If the Eyedropper tool is selected, 
pressing Alt or Option switches you to the Marker tool, which lets you apply the color or other for-
matting you just sampled to any object or text. (See Chapters 8, 11, and 19.)

Measure tool
Available through the Eyedropper tool’s pop-out menu, the Measure tool (shortcut K) opens the 
Info panel and lets you draw a line whose dimensions appear in that panel so that you can measure 
an arbitrary distance. You can see objects’ dimensions in the Control, Transform, and Info panels, 
but the value of the Measure tool is that it determines the distance between objects rather than the 
dimensions of objects. It can also come in handy when you’re measuring the distance across multi-
ple objects. (See Chapter 10.)

Hand tool
The Hand tool (shortcut H) lets you scoot pages around to view a different portion of a page or 
another page entirely. The Hand tool is an entirely visual method of scrolling, allowing you to see 
the page contents at all times. To use the Hand tool, click and drag in any direction. You can 
access the Hand tool temporarily without actually switching tools by pressing Option+spacebar or 
Alt+spacebar. (See Chapter 2.)

Zoom tool
The Zoom tool (shortcut Z) lets you increase and decrease the document view scale. You can high-
light a specific area on a page to change its view or you can click on-screen to change the view 
scale within InDesign’s preset increments (shown in the Zoom Level field and pop-up menu in the 
application bar).

Apply buttons
The bottom portion of the Tools panel contains buttons for applying colors to the edges of objects 
(strokes) and the insides of objects (fills). You use these buttons with the Stroke, Color, Gradient, 
and Swatches panels to apply and experiment with the colors applied to objects. (See Chapter 8.) 
Figure 1.3 identifies these buttons.

Screen Mode buttons
At the very bottom of the Tools panel (or at its far right if it’s in horizontal orientation, as explained 
later in this chapter) is the Screen Mode iconic button, which has five options: Normal, Preview, 
Bleed, Slug, and Presentation. (If the Tools panel is configured to be in two-column mode, you’ll 
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see the Normal iconic button at bottom left and the Preview iconic button at bottom right; the 
Preview iconic button also acts as a menu to access the other three screen modes.)

The Normal screen mode shows all InDesign indicators such as frame edges and the pasteboard, 
whereas the Preview mode shows the layout without any indicators, to simulate its final appear-
ance to the reader. 

New Feature
The new Presentation mode lets you show your layout as if it were a slideshow, such as for a client walk-
through presentation, as Chapter 2 explains. n

The Bleed screen mode shows any objects that bleed beyond the page boundaries, and the Slug 
mode shows the space reserved for information such as crop marks and color separation names 
used in final output, as covered in Chapters 4 and 31. You set these up when you create new docu-
ments or by choosing File ➪ Document Setup or pressing Option+Ô+P or Ctrl+Alt+P.

Note
These five view modes are also accessible by choosing View ➪ Screen Mode and then the desired option from 
the submenu, as well as from the Screen Mode iconic pop-up menu in the application bar (covered earlier in 
this chapter). n

Using tool tips and keyboard shortcuts
To start getting familiar with the tools, first make sure that the Tool Tips pop-up menu is set to 
Normal or Fast in the Interface pane of the Preferences dialog box (choose InDesign ➪ Preferences ➪ 

Interface or press Ô+K on the Mac, or choose Edit ➪ Preferences ➪ Interface or press Ctrl+K in 
Windows). Point at each tool to learn its official name, as shown in Figure 1.3; let the pointer rest 
on the tool for a few seconds (if Tool Tips is set to Normal) and a tool tip appears, telling you the 
name and shortcut key of that tool. 

Knowing the actual name is the key to learning about any tool — after all, neither the InDesign 
documentation’s index nor this book’s index lists tools by the way they look (for example, little 
black pointer or empty square); instead, if you want to look up a tool, you need to know the tool’s 
name (Selection tool or Rectangle tool, for example).

While you’re learning the tool names, you may notice a single letter in parentheses next to each 
tool name. This is the shortcut key to selecting that tool. For example, the (T) next to the Type tool 
indicates that pressing T selects the Type tool. The Tools panel’s shortcuts don’t use modifier keys 
such as Ô and Ctrl. If you’re editing text or otherwise have the Type tool selected — or if you’re in 
a text-entry field in a panel or dialog box — typing these shortcuts simply inserts the text where 
your cursor is.
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Caution
If you’re not careful, you can type nonsense text in your articles because of the way the Tools panel’s shortcuts 
work (without having to press Ô or Ctrl). n

Tip
To avoid typing these extra letters into your text, always use Ô+click or Ctrl+click to click anywhere on the 
page or pasteboard. Doing so releases the live text that you were working on before typing a single-letter 
keyboard shortcut. n

After you learn all the keyboard commands, you can create and refine a layout without ever reach-
ing for the Tools panel. In no time, you’ll be switching from the Scale tool to the Rotate tool with a 
quick punch of the R key, and then you’ll be pressing T to add a text frame. Now, obviously, you 
can’t use the keyboard commands for selecting tools while typing or editing text, but they are 
worth remembering for switching tools while designing a layout. In many production environ-
ments, copy editors handle text changes, whereas layout artists handle design issues. In such 
environments, the layout artists learn these shortcuts and the copy editors avoid them.

Opening and closing the Tools panel
Opening and closing the Tools panel is easy. One method of opening (or closing) the Tools panel 
is to choose Window ➪ Tools. The other method of opening (or closing) the Tools panel is more 
obscure: Pressing Tab (with any tool but the Type tool selected) closes all open panels, including 
the Tools panel. To reopen those panels, press Tab again. To reopen just the Tools panel, choose 
Window ➪ Tools. You can also close a floating Tools panel by clicking its Close box.

By default, the Tools panel is docked under the Control panel, but you can drag it out (drag the 
dark area at the very top) and make it a free-floating panel. Drag it back to the left of the monitor 
screen, right under the Control panel, to re-dock it.

You can change the Tools panel’s appearance, as Figure 1.6 shows, by clicking the double-arrow 
iconic button in the dock that contains the Tools panel. If the Tools panel is docked, you can 
toggle the panel between single-column and double-column. If the Tools panel is undocked, you 
get a third state: single-column horizontal. (Note how the double-arrow icons change direction as 
you toggle through the various states.) 

You can also set the display to any of these three settings — whether the panel is docked or not — 
in the Interface pane of the Preferences dialog box, using the Floating Tools Panel pop-up menu.

Note
A docked Tools panel has square corners, while an undocked Tools panel has rounded corners. n
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 FIGURE 1.6

The five forms of the Tools panel: docked and single-column, docked and double-column, floating and 
single-column, floating and double-column, and floating and horizontal. Note how undocked panels have 
rounded corners whereas docked ones have square corners.

Close box

Display toggle

Working with Panels and Docks
Initially, software developers used floating palettes to provide convenient access to commonly used 
options such as swatches, fonts, and styles. Palettes provide a more interactive method of working 
with features because the screen is not obscured by a large dialog box and you can access the con-
trols quickly. 

Eventually, palettes started to move away from serving as a convenient alternative to commands 
and became the primary method — often the only method — for performing many tasks. InDesign 
calls these floating palettes panels. Panels can have multiple sets of functions, with each set in its 
own tabbed pane. Figure 1.7 shows the interface elements in panels.

There are so many panels in InDesign CS5 — even more than in previous versions — that you 
might want to consider hooking up a second monitor for displaying them. Break out the computer 
glasses and your decoder ring, because the panels are small and laden with mysterious icons.

As with the tools, if you make sure Tool Tips is selected in the Interface pane of the Preferences 
dialog box (choose InDesign ➪ Preferences ➪ Interface or press Ô+K on the Mac, or choose 
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Edit ➪ Preferences ➪ Interface or press Ctrl+K in Windows), you can get some pretty good hints as 
to what the panel icons and fields do.

You can also manage what panels display, and switch among these view settings, using the work-
spaces feature described in Chapter 2.

 FIGURE 1.7

Anatomy of a panel. Panels contain a flyout menu that provides additional options. Floating panel groups 
also have a Close box to remove them from the display. Some panels have a hide/show options button to 
display and hide additional fields.

Arranging panels
InDesign places a set of panels in a dock at the right edge of your screen. The goal of this dock is to 
keep panels in a self-contained area, minimizing interface clutter. Because the Tools panel resides 
in its own dock, I call the one at the right side of the screen the main dock.

Note
The only panel that cannot be docked is the Quick Apply panel. n
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You access a panel by clicking its tab (if it is on-screen) and/or by choosing the desired panel from 
the Window menu. If you choose a panel from the Window menu not already in the dock, that 
selected panel appears on-screen as a free-floating panel.

Note
InDesign CS5 displays just a limited set of panels in the main dock when you install it — those in the Essentials 
workspace. I suggest that you switch to the Advanced workspace to get a useful set of panels in the dock as 
your default; to do so, choose Advanced from the Workspaces menu at the right side of the application bar, 
or choose Window ➪ Workspace ➪ [Advanced]. (Chapter 2 explains how to work with, and create your own, 
workspaces.) n

You can move panels in and out of panel groups, dragging them by their tabs. You can drag panels 
within the main dock or outside the dock (dragging them outside the dock makes them free-
floating). (If the dock is collapsed, just drag the panels by their names to pull them out or move 
them.) You can also drag free-floating panels into the dock.

Tip
To drag an entire panel group — all the panels whose tabs are in the same row in the dock — hold Option or 
Alt when you drag the tab of one of its panels. If a panel group is collapsed into the dock, just drag the dashed 
line that appears over its name to drag the entire panel group out of the dock. n

Some panels have additional fields that you can display by clicking the up/down arrow iconic but-
ton in the panels’ tabs. Clicking the icon again returns the panel to the normal display.

Tip
To close an individual panel, whether it’s inside the main dock or free-floating, you must drag it out into its 
own free-floating panel and then close that panel using its Close box. (To bring back a closed panel, select it 
from the Window menu.) Note that you can close an entire panel group by clicking its Close box. n

Changing the dock display
As with the Tools panel, you can drag the main dock from the right side of the screen and make 
it float, as well as drag it back and dock it there. (You can also drag the Control panel to make it 
free-floating.)

In addition to being able to move the main dock, you can adjust how it appears. You can widen or 
narrow the dock by its left edge when docked, and any edge when undocked.

You can also add panels to it by dragging them at the boundary of any existing panel or panel 
group on the dock, as well as remove panels and panel groups from the dock, as explained in the 
previous section.

The Interface pane of the Preferences dialog box gives you additional control over the dock’s dis-
play: If you enable Auto-Collapse Icon Panels, an open panel closes as soon as you click some-
where else in the program. This way is handier than manually collapsing the panel when done.
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Sometimes, panels get in the way of working on your layout. To quickly hide all panels, press Tab. 
(Make sure no text is selected if the Type tool is active; otherwise, you’ll enter a tab in your text. 
And make sure no dialog box or panel field is enabled; otherwise, you’ll move to another field.) To 
get them all back, press Tab again.

Tip
If you enable the Auto-Show Hidden Panels option in the Interface pane of the Preference dialog box, you can 
quickly open certain panels. (To set this preference, choose InDesign ➪ Preferences ➪ Interface or press Ô+K 
on the Mac, or choose Edit ➪ Preferences ➪ Interface or press Ctrl+K in Windows.) When you hide all panels by 
pressing Tab, you see a dark gray border on the left and right side of InDesign’s document window. Hover your 
mouse over the left border to display the Tools panel. Hover over the right border to display the main dock and 
any floating panels. (Note that you cannot show the Control panel this way; you must press Tab again.) n

Using panels
To use a panel, first you need to activate it. You can do this by clicking its tab (if the panel contain-
ing it is open) or by choosing its menu command in the Window menu (if the panel is not open or 
if another pane in that panel is active). You need to be on the lookout here — if a menu command 
brings a panel forward in the main dock or in a free-floating panel group, you might not even 
notice.

When a panel is active, you use its controls in the following ways:

l Click a pop-up menu to display and select an option, or click an icon to select an option; 
the changes take effect immediately.

l Highlight a value in a field to enter a new value. To implement the value, press Shift+Return 
or Shift+Enter, or you can press Tab to move to the next field or Shift+Tab to the previous 
field; or just click in a different field or elsewhere in the document. To get out of a field 
you’ve modified, leaving the object unscathed, press Esc.

l Some fields include up and down arrows that you can click to increase or decrease the 
value in the field.

l Fields accept values in all different measurement systems. (I cover field values in detail in 
Chapter 3.)

l In addition to typing values in fields, you can enter calculations. You can add to, subtract 
from, multiply, and divide values in fields using the following operators: +, –, * (multi-
ply), and / (divide). For example, to reduce the width of a frame by half, you might type 
/2 next to the current value in the Width field (such as 4.5"/2). Or, to increase the length 
of a line by 6 points, you can type +6 next to the current value in the Length field (such 
as 23pt+6).

l Most panels provide a pop-up menu, called a flyout menu, that you can display by clicking 
the iconic button in the upper-right corner. The flyout menu provides commands related 
to the current panel’s contents.
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Tip
You can also use percentages in fields, such as 50%, which adjusts the current value by that percentage. n

Checking out the panels
As does each tool in InDesign, each panel has a distinct function. I cover the use of each panel in 
detail in the appropriate chapters throughout this book. (For example, the Layers panel is covered 
in Chapter 6.) But with the help of Tool Tips and a quick introduction to their primary purpose, 
you can start using many of the panels to begin performing basic functions.

Tip
All but one of the text-oriented panels are available from the Type menu: Character, Character Styles, Glyphs, 
Index, Paragraph, Paragraph Styles, and Tabs. (The Table panel and its related Table Styles and Cell Styles pan-
els are not available here, but that’s because they have their own Table menu for accessing their controls.) 
Having this menu provides faster access than choosing Window ➪ Type & Tables ➪ submenu and Window ➪ 

Styles ➪ submenu does. n

Here is a quick summary of the InDesign panels. Note that in the figures of the various panels, the 
full panel is shown for any that have the option of showing just some options; these panels have an 
up-down arrow iconic button to the left of the panel name.

New Feature
Panels new to InDesign CS5 are the Access CS Live, Animation, Background Tasks, CS News and Resources, CS 
Review, Media, Mini Bridge, Object States, Preview, Timing, Tool Hints, and Track Changes panels. Gone is the 
Connections panel, whose functionality is now part of the new Access CS Live panel. InDesign CS5 has also 
rearranged where some panels appear in the Window menu. n

Basic control panels
Five panels are widely used in InDesign to provide basic functionality relating to objects:

l Tools panel (choose Window ➪ Tools): As covered earlier in this chapter, the Tools 
panel is the mechanism by which you select the appropriate tool to accomplish various 
layout tasks.

l Control panel (choose Window ➪ Control or press Option+Ô+6 or Ctrl+Alt+6): The 
Control panel is one of the most useful features in InDesign. It combines many attributes 
for the currently selected object so that you can minimize the use of other panels and 
menu items. The panel changes based on what you select, as shown in Figure 1.8.

 The Control panel adjusts its display based on what the current object is, so you get just 
the relevant options. For example, when you select a text frame, the Control panel pro-
vides the most functions of the Transform, Character Style, Character, Paragraph, 
Paragraph Styles, and Stroke panels — and the wider your screen, the more options 
appear in it.
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 FIGURE 1.8

From top to bottom: The Control panel for frames, text paths, and Bézier shapes selected 
with the Selection tool (as well as with the Direct Selection tool for frames and shapes 
not containing placed graphics); the Control panel for lines selected with the Selection 
or Direct Selection tool; the Control panel for frames with frames and Bézier shapes 
with graphics in them selected with the Direct Selection tool; and the two Control panel 
versions for text frames and text paths with text selected with the Type tool. More 
options appear if your monitor resolution is 1152 pixels or wider.

New Feature
The Control panel now includes swatch controls to set the fill and stroke colors for selected objects. n

l Transform panel (choose Window ➪ Object & Layout ➪ Transform): The Transform 
panel lets you specify size, placement, scale, rotation, and shear of selected objects. It 
duplicates much of the Control panel, so it’s seldom used.

InDesign lets you customize the Control panel, which you do using the Customize flyout menu option. 
This is especially useful if you are working with a monitor whose screen resolution is set at less than 
1152 by 872 pixels, because InDesign automatically removes options from the Control panel at smaller 
screen sizes. By customizing the Control panel, you can keep the options you want and remove the 
ones you don’t, rather than accept what InDesign thinks you should have.

In the Customize Control Panel dialog box that appears when you select Customize from the flyout 
menu, you can select and deselect sets of iconic buttons to control which ones appear. These objects 
are grouped into five categories — Object, Character, Paragraph, Tables, and Other. You can control 
individual buttons within these categories by clicking the right-facing arrow icon to the left of each 
group’s name; you get a list of options within that group that you can individually control.

The Control panel also adds several functions to its options if you have a wide-screen monitor. For 
example, with a monitor set at a width of 1280 pixels, you see both the character and paragraph 
options simultaneously, rather than have to toggle between them. When you’ve selected an object with 
the Selection tool at that resolution, you see extra controls such as frame alignment and frame fitting.

Customizing the Control Panel
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l Links panel (choose Window ➪ Links or press Shift+Ô+D or Ctrl+Shift+D): The Links 
panel shows the original location of imported graphics and text files. (See Chapter 13.)

l Info panel (choose Window ➪ Info or press F8): The Info panel shows some of the 
characteristics — such as size, position, and cropping — of selected objects. It also dis-
plays the results of using the Measure tool.

Text-formatting panels
Five panels are used in InDesign to provide functionality related to text formatting:

l Glyphs panel (choose Type ➪ Glyphs or Window ➪ Type & Tables ➪ Glyphs, or 
press Option+Shift+F11 or Alt+Shift+F11): The Glyphs panel lets you access special 
characters within a font. (See Chapter 23.)

l Character panel (choose Type ➪ Character or Window ➪ Type & Tables ➪ Character, 
or press Ô+T or Ctrl+T): Use the Character panel to change common attributes of high-
lighted text such as the font, size, leading, kerning, tracking, and scaling. (See Chapter 20.)

l Paragraph panel (choose Type ➪ Paragraph or Window ➪ Type & 
Tables ➪ Paragraph, or press Option+Ô+T or Ctrl+Option+T): Use the Paragraph 
panel to change common attributes of selected paragraphs such as alignment, indents, 
space before and after, and hyphenation. (See Chapter 21.)

l Character Styles panel (choose Type ➪ Character Styles or 
Window ➪ Styles ➪ Character Styles, or press Shift+Ô+F11 or Ctrl+Shift+F11): Use 
the Character Styles panel to create and apply styles consisting of character-level formats. 
(See Chapter 20.)

A fast way to apply various attributes to layout elements is by using the Quick Apply panel. Quick 
Apply is a consolidated list of styles, scripts, text variables, and other attributes that you access by 
choosing Edit ➪ Quick Apply, by clicking the Quick Apply button (the lightning-bolt icon) in many 
panels, or by pressing Ô+Return or Ctrl+Enter. The Quick Apply panel presents all available options in 
an alphabetical list. You can scroll down to the one you want or type the first few letters of the attribute 
in the text field at the top to jump to attributes beginning with those letters, and then navigate to the one 
you want and press Return or Enter, which brings you back to where you were working and closes the 
Quick Apply panel.

The Quick Apply Panel
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l Paragraph Styles panel (choose Type ➪ Paragraph Styles or Window ➪ Styles ➪ 

Paragraph Styles, or press Ô+F11 or Ctrl+F11): Use the Paragraph Styles panel to cre-
ate and apply styles consisting of paragraph-level formats. (See Chapter 21.)

Table-formatting panels
Four panels are used in InDesign to provide functionality related to tabular formatting (see Chapter 25):

l Table panel (choose Window ➪ Type & Tables ➪ Table or press Shift+F9): The Table 
panel lets you adjust table settings.

l Tabs panel (choose Type ➪ Tabs, or press Shift+Ô+T or Ctrl+Shift+T): The Tabs 
panel lets you create tab stops for selected paragraphs; you can also specify alignment, 
position, and leader characters for the tabs. Note that Adobe calls this panel a dialog box, 
but it does not work like any other dialog box: It has no OK or Cancel buttons, and — 
unlike when a regular dialog box is open — you can select items in your layout while it is 
open. It really is a panel, except that it has no Minimize box. So I’m still calling it a panel.

l Table Styles panel (choose Window ➪ Styles ➪ Table Styles): The Table Styles panel 
lets you specify and apply styles for tables.

l Cell Styles panel (choose Window ➪ Styles ➪ Cell Styles): The Cell Styles panel lets 
you specify and apply styles for table cells.

Text-management panels
Six panels are used in InDesign to provide functionality related to managing text, such as for cross-
references and notes.

l Conditional Text panel (choose Windows ➪ Type & Tables ➪ Conditional Text): The 
Conditional Text panel is where you apply or remove conditions applied to text, as 
Chapter 26 explains.

l Index panel (choose Window ➪ Type & Tables ➪ Index or press Shift+F8): The Index 
panel lets you add and manage index entries. (See Chapter 27.)

l Assignments panel (choose Window ➪ Editorial ➪ Assignments): The Assignments 
panel lets you make individual stories in your layout available to a user of the InCopy 
add-on program (see Chapter 24). For example, with InCopy, a copy editor can check out 
a story from your layout to proofread it while you’re still working on the layout.

This feature can be handy if you’re working on layouts from your keyboard — perhaps you’re a layout 
artist working on a notebook while commuting. For example, you can switch to the Quick Apply panel, 
apply a style, and return to your object or text, all without touching the mouse.

But there are so many options in the Quick Apply panel’s default state that you can quickly get over-
whelmed. To remove attributes you likely will never use in this panel — such as scripts and menu 
customizations — choose the unnamed pop-up menu at the top of the panel and deselect unwanted 
attributes (the check marks indicate attributes that will appear).
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l Track Changes panel (choose Window ➪ Editorial ➪ Track Changes: The new Track 
Changes panel lets you track and manage text changes made to the layout. (See Chapter 24.)

l Notes panel (choose Window ➪ Editorial ➪ Notes): The Notes panel lets you insert and 
manage nonprinting notes used as reminders for yourself or other people working on the 
layout. (See Chapter 19.)

l Data Merge panel (choose Window ➪ Utilities ➪ Data Merge): The Data Merge panel 
lets you import data for use in form letters, labels, and other mail-merge documents. (See 
Chapter 26.)

Object management panels
Seven panels are used in InDesign to provide functionality related to formatting and managing objects:

l Object Styles panel (choose Window ➪ Styles ➪ Object Styles, or press Ô+F7 or 
Ctrl+F7): Use the Object Styles panel to create and apply styles for frames, lines, and 
other objects. (See Chapter 13.)

l Text Wrap panel (choose Window ➪ Text Wrap, or press Option+Ô+W or Ctrl+Alt+W): 
The Text Wrap panel provides iconic buttons for controlling how text runs around 
selected objects. (See Chapter 13.)

l Align panel (choose Window ➪ Object & Layout ➪ Align or press Shift+F7): The 
Align panel provides buttons that let you evenly distribute or realign multiple selected 
objects with one click. (See Chapter 10.)

l Stroke panel (choose Window ➪ Stroke, or press Ô+F10 or Ctrl+F10): Use the Stroke 
panel to outline the edges of frames and lines; you have control over the thickness and the 
pattern of the outlines. (See Chapter 12.)

l Pathfinder panel (choose Window ➪ Object & Layout ➪ Pathfinder): As Chapter 16 
explains, the Pathfinder panel lets you manipulate paths, enabling you to combine, sepa-
rate, and otherwise work with open and closed paths. It also lets you convert shapes. 
(Note that the Pathfinder panel has no flyout menu.)

l Effects panel (choose Window ➪ Effects or press Shift+Ô+F10 or Ctrl+Shift+F10): 
The Effects panel lets you adjust the solidity of images to create transparency and lighting 
effects. (See Chapter 12.)

l Attributes panel (choose Window ➪ Output ➪ Attributes): As Chapters 12 and 29 
explain, the Attributes panel lets you specify whether objects print, as well as control how 
the stroke or fill in selected objects overprints the background. (Note that the Attributes 
panel has no flyout menu.)

Layout management panels
Three panels are used in InDesign to provide functionality related to formatting and managing of 
pages and the overall layout.

l Pages panel (choose Window ➪ Pages or press Ô+F12 or Ctrl+F12): Use the Pages 
panel to create master pages and to add, rearrange, and delete document pages. You can 
also create sections of page numbers using the Pages panel’s flyout menu. (See Chapter 5.)
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l Layers panel (choose Window ➪ Layers or press F7): The Layers panel provides access 
to vertical slices of a document that you can use to control the stacking order of objects, to 
isolate specific portions of a design, or to store revisions of the same document. (See 
Chapter 6.)

l Story panel (choose Type ➪ Story or Window ➪ Type & Tables ➪ Story): Small but 
important, the Story panel lets you specify hanging punctuation for all the frames in a 
story by checking Optical Margin Alignment, as Chapter 22 explains. You can also change 
the type size at which alignment begins if the need arises. (Note that the Story panel has 
no flyout menu.)

Color management panels
Four panels are used in InDesign to provide functionality related to definition and managing of 
color, as Chapter 8 explains:

l Swatches panel (choose Window ➪ Color ➪ Swatches or press F5): The Swatches 
panel lets you create named colors such as those using Pantone, Focoltone, and Toyo inks, 
and apply the colors to text, strokes, and fills.

l Color panel (choose Window ➪ Color ➪ Color or press F6): The Color panel lets you 
create Lab, CMYK, and RGB colors, and apply the colors to text, strokes, and fills. (Lab, 
CMYK, and RGB are all composite color models, in which all colors are made by mixing a 
small number of primary colors.) Chapter 8 describes these models in detail.

l Gradient panel (choose Window ➪ Color ➪ Gradient): Use the Gradient panel to create 
a stroke or fill consisting of a graduated blend between two colors.

l Kuler panel (choose Windows ➪ Extensions ➪ Kuler): Use the Kuler panel to load color 
palettes created by others, modify them, and create your own, as well as transfer them to 
the Swatches panel and share them with other Kuler.com users.

Prepress and output management panels
Four panels are used in InDesign to provide functionality related to adjusting and previewing the 
final print output of your layouts. Note the Attribute panel, described in the Object management 
panels section, also controls some final output settings for selected objects:

l Preflight panel (choose Window ➪ Output ➪ Preflight, or press Option+Shift+Ô+F or 
Ctrl+Alt+Shift+F): The Preflight panel lets you determine what settings InDesign should 
check for output violations as you work on your file, as well as see what current objects 
have such violations.

l Flattener Preview panel (choose Window ➪ Output ➪ Flattener): The Flattener Preview 
panel lets you see what page items (typically those with transparency) are flattened (made 
solid) during printing or exporting to Encapsulated PostScript (EPS) or Portable 
Document Format (PDF) formats. Flattening occurs for printing devices and graphics 
export formats that don’t support transparency.

l Separations Preview panel (choose Window ➪ Output ➪ Separations or press 
Shift+F6): The Separations Preview panel lets you see page items with various color plates 
enabled, as well as preview the effects of different ink densities.
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l Trap Presets panel (choose Window ➪ Output ➪ Trap Presets): The Trap Presets panel 
lets you set and apply different trapping settings to objects, which controls how abutting and 
overlapping objects print to avoid gaps caused by paper-feed variations during printing.

Web and interactive media management panels
Nine panels are used in InDesign to provide functionality related to interactive elements of docu-
ments intended for export to Web, Flash, or PDF files. Part VIII explains how to use these panels:

l Hyperlinks panel (choose Window ➪ Interactive ➪ Hyperlinks or Window ➪ Type & 
Tables ➪ Cross-References): The Hyperlinks panel lets you set up hyperlinks from and 
to document objects and pages, as well as to World Wide Web locations. It also lets you 
create cross-references for use in automatic text.

l Bookmarks panel (choose Window ➪ Interactive ➪ Bookmarks): The Bookmarks panel 
creates the bookmarks used in PDF files to create clickable indexes and tables of contents.

l Buttons panel (choose Window ➪ Interactive ➪ Buttons): The Buttons panel sets push-
button actions for PDF and Flash files.

l Page Transitions panel (choose Window ➪ Interactive ➪ Page Transitions): The Page 
Transitions panel sets page-transition effects for PDF and Flash files.

l Animation panel (choose Window ➪ Interactive ➪ Animation): The new Animation 
panel lets you set up and manage animations for Flash files.

l Timing panel (choose Window ➪ Interactive ➪ Timing): The new Timing panel lets you 
assign the times for various animated objects’ display and actions.

l Object States panel (choose Window ➪ Interactive ➪ Object States): The new Object 
States panel lets you assign and manage states for objects, for use with interactive Flash 
documents.

l Media panel (choose Window ➪ Interactive ➪ Media): The new Media panel lets you 
access and manage video files for PDF and Flash files.

l Preview panel (choose Window ➪ Interactive ➪ Preview): The new Preview panel lets 
you preview how PDF files, Flash files, and Web pages work — including their interactive 
objects and animations — while you are creating them, before exporting them as final files.

Automation panels
Three panels are used in InDesign to provide automation-oriented programming capabilities, as 
Part IX explains:

l Scripts panel (choose Window ➪ Utilities ➪ Scripts, or press Option+Ô+F11 or 
Ctrl+Alt+F11): The Scripts panel shows available AppleScript, VBA, and JavaScript 
scripts in the Scripts folder in the InDesign folder.

l Script Label panel (choose Window ➪ Utilities ➪ Script Labels): The Script Label 
panel lets you change the label of an object for use by scripts. (Note that the Script Label 
panel has no flyout menu.)
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l Tags panel (choose Window ➪ Utilities ➪ Tags): The Tags panel lets you add XML tags 
and map them to paragraph and character styles. XML tags determine the formatting for 
XML data sources used in XML documents, which are typically used for automated docu-
ment production and conversion.

Specialty information panels
InDesign has three panels meant to provide specialized information to users:

l Mini Bridge (choose Window ➪ Mini Bridge): The new Mini Bridge panel lets you 
inspect files on your computer using a simplified version of the Creative Suite’s Adobe 
Bridge application within InDesign.

l Tool Hints panel (choose Window ➪ Utilities ➪ Tool Hints): The new Tool Hints panel 
provides a description of the currently selected tool to explain how it works. What’s par-
ticularly handy about this panel is that it tells you what capabilities are enabled for each 
tool based on what modifier keys (such as Ô, Ctrl, Option, and Alt) you press when using 
the tool.

l Background Tasks panel (choose Window ➪ Utilities ➪ Background Tasks): The new 
Background Tasks panel shows the status of activities running behind the scenes, such as 
the status of a print job or PDF export. (In previous versions of InDesign, you had to wait 
until such tasks were complete before you could return to working on your layout. In 
InDesign CS5, you no longer have to wait, and instead can check on the status of such 
actions in this panel.)

CS Live panels
Three panels are used in InDesign to connect to Adobe’s subscription-based online collaboration 
services (an Internet connection is needed to use them): 

l Access CS Live panel (choose Window ➪ Extensions ➪ CS Live): The new Access CS 
Live panel provides quick access to each of Adobe’s CS Live online services, as well as lets 
you set up your CS Live account or connection from InDesign to it.

l CS News and Resources panel (choose Window ➪ Extensions ➪ CS News and 
Resources): The new CS News and Resources panel displays information about Creative 
Suite resources.

l CS Review panel (choose Window ➪ Extensions ➪ CS Review): The new CS Review 
panel lets you manage and view collaborative project reviews. The capabilities are quite 
basic: You can upload a static image of one or more spreads in your layout to Acrobat.com 
and then invite others to see the preview images and add sticky note comments. (Any 
interactive, video, audio, or animated objects won’t work in the CS Review preview; the 
viewers see only a placeholder graphic for such elements.)
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Reviewing Menu Commands
With so many panels, menu commands take on a more secondary function in InDesign. Many 
menu commands do nothing but display a panel or bring it forward — this is especially true in the 
Type and Table menus. But to get comfortable in InDesign, you need to know the basic function of 
each menu.

InDesign menu
Available only on Mac OS X, the InDesign menu contains preference and plug-in settings, as well 
as the command to exit the program and to hide it. The Services menu option lets you access mini-
applications in Mac OS X that apply to whatever is selected in InDesign, such as taking an image of 
the current screen. Note that there are very few such services relevant to InDesign. Note that none 
of these menu items’ functions are available in panels.

The CS Live service introduced with Creative Suite 5 provides the following capabilities. 

CS Review lets you upload preview images of your InDesign (and Photoshop and Illustrator) pages to a 
private area on Adobe’s Acrobat.com site from which you can invite other people to view the previews 
and add their comments to the project in the form of sticky notes. You use the CS Review panel to 
upload the pages and to open in your browser any documents being reviewed so you can see the com-
ments. (You can also choose File ➪ Create New Review or use the Access CS Live panel to create a new 
CS Review project.)

Note that pages using InDesign’s interactive and animation features display as static previews in CS 
Review, so you can’t use it to preview interactive features. You’ll need to use the Share My Screen 
capability of CS Live — or e-mail or otherwise share PDF and Flash files — to show these capabilities.

Buzzword is a very basic online text editor that allows multiple people to work on the same document, 
similar to Google Docs. Note that styles are not supported in Buzzword, so all text formatting is local 
and thus hard to manage when imported into InDesign. Chapter 17 explains how to use Buzzword 
documents in InDesign. You can create a Buzzword document from the Access CS Live panel.

Share My Screen — first introduced in Creative Suite 4 — lets you use Acrobat.com’s Connect Pro ser-
vice to let others see your InDesign or other Adobe applications’ screens live, so you can demonstrate 
your comps over the Internet. Choose File ➪ Share My Screen to initiate a screen-sharing session, or use 
the Access CS Live panel. (You can also use other sharing services, such as Yuuguu.com and WebEx, 
for such Internet-based demos, or the built-in screen-sharing capabilities of Mac OS X and Windows 
using instant messaging or local network connections.)

CS Live offers free and paid versions, depending on the number of users who get access to your 
documents.

A Quick Tour of CS Live
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Platform Difference
The InDesign menu is available only on the Mac. In Windows, the About InDesign and Manage Extensions 
menu options reside in the Help menu, the Preferences menu option resides in the Edit menu, and the Quit 
InDesign menu option resides in the File menu. The other InDesign menu options are specific to Mac OS X. n

File menu
The File menu lets you perform actions on entire documents, libraries, and books, including creat-
ing, opening, saving, closing, exporting, and printing. The Place command lets you import graph-
ics and text files, and the Export command lets you save documents in different formats such as 
EPS, RTF, XML, and PDF. The Windows version also includes the Quit menu option. Note that 
none of these menu items’ functions are available in panels.

New Feature
InDesign CS5’s File menu has the new Place from Buzzword option (see Chapter 17), combines the old Export 
for Digital Editions and Export for Dreamweaver options into the new Export For menu option (see Chapters 33 
and 34), and drops the Preflight menu option (see Chapter 30). n

Edit menu
InDesign’s Edit menu provides access to its invaluable multiple undo and redo features, as well as 
the standard Cut, Copy, Paste, and Clear commands. You’ll find Duplicate, and Step and Repeat 
here, even though you might be searching the Object menu for them. The Edit menu also provides 
commands for searching and replacing text and formats, checking spelling, and editing spelling 
and hyphenation dictionaries, as well as for opening the Story Editor text-editing feature and set-
ting up stories for the InCopy add-on program. 

It also provides access to color settings and keyboard shortcut preferences. Note that these menu 
items’ functions, except for Quick Apply, are not available in panels.

Platform Difference
The Windows version of the Edit menu also contains the Preferences menu option (which is in the InDesign 
menu on the Mac). n

Layout menu
With the Layout menu, you can change the position of the column and margin guides you estab-
lished in the New Document dialog box, create guides at specific locations, and resize an entire 
document proportionally. You can also turn pages in a document and insert automatic page num-
bers using Layout menu commands. Finally, this menu contains the commands for setting up 
tables of contents. Note that these menu options’ functions — except for the Pages, page-
navigation, and Numbering & Section Options menus — are not available in panels.
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Type menu
The Type menu provides all your controls for formatting text — character formats, paragraph for-
mats, tabs, and styles. The Story command lets you specify hanging punctuation for all the frames 
in a story (the same function as in the Story panel). You can also convert text to a frame and insert 
special characters using a dialog box rather than keyboard shortcuts. Note that the Find Font, 
Change Case, Type on a Path, Document Footnote Options, Text Variables, Insert Character, Fill 
with Placeholder Text, and Show Hidden Characters menu items’ functions are not available 
though panels.

New Feature
InDesign CS5’s Type menu has a new option: Track Changes (see Chapter 24). n

Object menu
Use the Object menu for layout functions such as controlling the stacking order of lines and 
frames, grouping objects together, locking objects to the page, and wrapping text around objects.

You can manipulate objects, such as changing the number of columns and text inset in the Text 
Frame Options dialog box or fine-tuning the corners of a frame using the Corner Options dialog 
box. For working with graphics, the Object menu lets you fit graphics to frames and frames to 
graphics, create clipping paths, merge and separate paths, convert shapes, apply colors to some 
types of images, and create drop shadows and apply other lighting effects. 

Note that the Text Frame Options, Anchored Object, Corner Options, Clipping Path, and Convert 
Shape menu items’ functions are not available through panels.

New Feature
InDesign CS5’s Object menu has several new options: Show and Hide (see Chapter 10), Captions (see Chapter 
13), and Convert Points (see Chapter 16). n

Table menu
The Table menu contains the controls to create and edit tables. Using commands from this menu, 
you create tables, modify them, convert text into tables and vice versa, manage table cells, and con-
trol row and column spacing. Note that this menu’s functions are available through panels.

View menu
With the View menu, you can change the view scale of the document, choose whether objects 
placed by master pages appear, and specify which layout tools are visible: Threads (links between 
text frames), the edges of frames, rulers, guides, the baseline grid, and the document grid. You can 
also specify whether guides are locked and whether items snap to guides and the document grid. 
Note that none of these menu items’ functions, except for Screen Mode and the zoom controls, are 
available in panels.
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New Feature
InDesign CS5’s View menu moves several show/hide options — including those for hyperlinks, notes, text 
threads, frame edges, and assigned frames — into the new Extras menu option. Some menu options, such as 
Structure, have been moved to new locations. n

Tip
If you’re expecting to use the View menu to show and hide invisible characters such as spaces and tabs, look in 
the Type menu instead. n

Window menu
For the most part, the Window menu opens panels or brings panels forward within their panel 
group. Other commands let you manage document windows, opening additional windows for the 
same document and redistributing document windows on-screen. Currently open documents are 
listed at the bottom of the menu. The window display and workspace functions are not available 
via panels.

New Feature
As described in this chapter, the Window menu offers new menu options for new panels, as well as rearranges 
the locations of some menu options. n

Help menu
The Help menu contains links to Adobe’s HTML help files, as well as to Adobe’s program update, 
registration, and activation functions. Note that none of these menu items’ functions are available 
in panels.

Platform Difference
The Windows version of the Help menu also contains the About InDesign and Manage Extensions menu 
options that are in the InDesign menu on the Mac. n

Contextual menus
An interface element you’ll find quite useful in InDesign is the contextual menu. By 
Control+clicking or right-clicking the document, an object, the rulers, items listed in a panel, and 
so on, you can display a menu of options for modifying whatever it is you’re clicking. 

Figures 1.9 through 1.11 show 11 contextual menus: 

l Two variants of one contextual menu for frames

l Two variants when you’re using the Type tool

l Two affecting the rulers

l One for the document tab
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l One for a panel group

l Three examples of contextual menus for panels.

 FIGURE 1.9

From left to right: The contextual menus for a graphics frame or shape, for a text frame, for a text-insertion 
point, and for selected text

 FIGURE 1.10

From left to right: The contextual menus for the zero point, rulers, a document tab, a panel group, and an 
empty portion of a page or of the pasteboard
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 FIGURE 1.11

Many panels offer contextual menus for listed items, such as the Paragraph Styles panel (upper left), 
Swatches panel (lower left), Pages panel (center), and Links panel (right).

Undoing What You’ve Just Done
Sometimes, you do something you didn’t mean to — or you did mean to do it but don’t like the 
results. InDesign gives you several ways to deal with changing your mind:

l Choosing Edit ➪ Undo or pressing Ô+Z or Ctrl+Z for most actions. Some actions, par-
ticularly actions such as scrolling that do not affect any items or the underlying document 
structure, are not undoable. You can undo multiple actions in the order they were done 
by choosing Edit ➪ Undo or pressing Ô+Z or Ctrl+Z — each time you undo, and the pre-
vious action is undone.

l If you change your mind while InDesign is still completing the action, pressing Esc 
usually cancels the operation.

l When working in most dialog boxes, you can revert all settings to what they were 
when you opened the dialog box. Just press Option or Alt, which changes the Cancel 
button into a Reset button, and then click Reset.

If you’ve undone something that you decide you didn’t want to undo, InDesign has a way to help 
here as well: Choose Edit ➪ Redo or press Shift+Ô+Z or Ctrl+Shift+Z. This will redo whatever you 
undid via Edit ➪ Undo, or Ô+Z or Ctrl+Z. It does not reinstate a canceled operation or a reverted 
dialog box.

Alternatively, choosing Undo and Redo is a handy way of seeing a before/after view of a particular 
change. As with Undo, you can redo multiple undone actions in the order in which they were 
undone. If you’ve made lots of changes to your document and you want to jettison them all, you 
can choose File ➪ Revert to reopen the file as it was when you last saved it.
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Summary
InDesign stores its preferences in a file that you can copy and send to other users to ensure that 
you use a standard interface in workgroups. It offers its functionality through a variety of interface 
methods: tools, panels, menu options, and contextual menus, as well as through some navigation 
controls in the document window.

The application bar gives you quick access to many InDesign display-oriented functions such as 
zooming and managing document display.

Panels are the primary vehicle for accessing InDesign features, whereas tools — accessed via the 
Tools panel — are the primary vehicle for determining what actions are possible.

You can move panels into the main dock to keep them self-contained at the right side of your 
screen. You can also move, separate, and combine panels into panel groups of your choice, both 
within the main dock or as free-floating panel groups. New panels are Access CS Live, Animation, 
Background Tasks, CS News and Resources, CS Review, Media, Mini Bridge, Object States, 
Preview, Timing, Tool Hints, and Track Changes.

The Control panel is a great timesaver, grouping many functions into one panel, showing only the 
relevant options for different kinds of objects as they are selected.

You can undo and redo most actions, giving you greater ability to experiment.
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